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GUÍA BÁSICA DE REFERENCIAS CON MENDELEY 

Por Marcia Paredes A.  
Dudas/Comentarios a marcia.paredes.a@gmail .com  

 

Mendeley es un programa de escritorio que se puede descargar de manera gratuita 

que sirve para manejar las referencias bibliográficas que hemos encontrado en el desarrollo 

de cualquier investigación. Es una herramienta poderosa para agilizar el uso de citas dentro 

de un documento, puesto que almacena la información de cada 

libro/informe/reporte/paper/etc y lo cita en la norma de nuestra elección.  

La siguiente guía tiene por finalidad mostrar cómo utilizar Mendeley Desktop en 

informes desarrollados en Word y Latex. 

 

PASO 1: Obtener el programa 
Para obtener el instalador ejecutable, nos dirigimos a la dirección 

https://www.mendeley.com/download-desktop-new/ en nuestro navegador 

predeterminado. El link anterior nos llevará a descargar la versión desktop de Mendeley 

(también existe una versión plug-in para navegadores), donde podrán elegir su sistema 

operativo y comenzar la descarga. Luego ejecutamos el .exe y esperamos a que termine 

la instalación.  

Una vez terminado el proceso, iremos a crear una nueva cuenta en Mendeley desde 

su página web https://www.mendeley.com/ haciendo click en “Create account”. Nos 

aparecerá una página en la que debemos ingresar nuestros datos (email, nombre, apellido, 

contraseña). ¡Le dan a “Register” y habremos creado nuestra cuenta! 

 

PASO 2: Entender la interfaz 
 De nada nos sirve tener un programa bonito sin entender qué nos está queriendo 

decir.  Para comenzar, abrimos Mendeley Desktop desde el Inicio; este nos pedirá nuestras 

credenciales con las que nos registramos anteriormente para poder loggearnos al sistema. 

Una vez abierta la interfaz, nos mostrará la siguiente ventana: 

mailto:marcia.paredes.a@gmail.com
https://www.mendeley.com/download-desktop-new/
https://www.mendeley.com/
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Ilustración 1: Layout de la página principal de Mendeley Desktop. 

 Como pueden ver, yo ya tengo un par de documentos guardados en mi librería. 

Para ser más ordenados, podemos crear carpetas apretando “Folder” en la esquina 

superior izquierda de Mendeley. Las carpetas son colecciones privadas de documentos, 

por lo que sólo ustedes tienen acceso a sus contenidos. 

 

Ilustración 2: Creación de una nueva carpeta en nuestra librería. 
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 Si necesitan hacer tareas en grupo, pueden crear un nuevo grupo en “Create 

Group” debajo de My Library. Tendrán la opción de hacerlo público, sólo accesible con 

invitación, o privado. La ventaja de los grupos es que más de una persona puede agregar 

referencias, y es más fácil encontrar los documentos que se quieren citar en Word. 

Recuerden apretar “Sync” en los botones superiores para sincronizar sus librerías con las de 

sus compañer@s. 

 

Paso 3: Agregar documentos a la librería 
 Intentemos agregar nuestro primer archivo a la carpeta Tutorial. Imaginaré que 

tengo que hacer una tarea sobre “pantanos”, así que buscaré material en la Biblioteca 

Digital Uchile o Google Schoolar, donde encontré el siguiente artículo: 

 

Ilustración 3: Vista previa al documento que agregaremos a la librería. Buscamos en la página el PDF 

y el DOI (u otro identificador). 

  

Acá hay dos cosas importantes que hacer: descargar el PDF y encontrar el DOI. 

¿Qué es el DOI? Es un identificador de objetos digitales único para cada archivo, por lo este 

tiene gran cantidad de información sobre las referencias que necesitamos. En el ejemplo, 

el DOI se encuentra bajo el Autor, pero en libros este suele estar antes del índice de 

contenidos. Si no encontramos el DOI no hay problema, eso sólo significará que tendremos 

que rellenar los campos en Mendeley de forma manual. 

 Copiamos el DOI completo en nuestro portapapeles y volvemos a Mendeley. 

Hacemos click derecho a la ventana central y seleccionamos “Add Entry Manually”. 
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Ilustración 4: Ventana desplegable al crear una Entry manualmente. Contiene las casillas a rellenar 

según el tipo de documento. 

 Pegamos el DOI del documento en la casilla de identificadores y apretamos la lupa 

del costado derecho. ¡El resto de las casillas se rellenan solas! 

 

 

Ilustración 5: Datos del documentos rellenados automáticamente con el DOI. 

 Por último, en la casilla de Files (en la misma ventana mostrada antes) agregamos el 

PDF que descargamos. Apretamos “Save” y nuestra ventana de Mendeley se verá de la 

siguiente manera: 
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Ilustración 6: Primer documento agregado a la librería. El punto verde al lado del archivo PDF indica 

que no hemos leído el documento dentro de la interfaz de Mendeley. 

 Opcional: Hacer click derecho sobre el documento y seleccionar “Update Details”. 

Esto hará que Mendeley lea el archivo PDF que agregamos para corregir ciertos campos 

que entregó el DOI y/o rellenar campos vacíos. Es importante verificar que este relleno 

automático no cambie datos relevantes (Ej de posibles errores: Cambio del título por el 

subtítulo, cambio en el año de publicación por el de revisión, intercambio entre título del 

documento y el nombre de la revista, etc). 

 Acá podemos ver mi Mendeley después de agregar dos documentos más (un libro 

y otro paper sobre el mismo tema). 

 

 

Ilustración 7: Nuestra librería va creciendo... 
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 ¿Se acuerdan del Citation Key? ¿La casilla dentro de la ventana de Add Entry 

Manually? Al apretar “Update Details” en cada documento, esta debió haberse rellenado 

sola de la forma “Apellido+Año”, pero es posible cambiarla si lo desean. Para ello, hagan 

click en el documento que les interesa, y busquen el Citation Key en el Panel de Información 

→ Details. 

 

Ilustración 8: Citation Key autocompletado en la ventana de Details. 

 El Citation Key nos servirá si queremos hacer referencias en LateX, puesto que el 

comando \cite{} requiere que referenciemos el artículo con algún tipo de etiqueta. 

Agregar el Citation Key en Mendeley nos ahorrará tiempo en LateX, pero en Word no es de 

gran utilidad. 

 Si queremos ver como se verán las referencias, vamos a View → Library as Citation y 

veremos lo mostrado en la Ilustración 9. Si nos interesa otro estilo de cita, volvemos a View 

→ Citation Style → More Styles… Mendeley tiene una gran variedad de estilos disponibles 

ya instalados; también es posible descargar nuevos estilos en la pestaña “Get more styles” 

al escribir el nombre en el buscador. 

 

Ilustración 9: Nuestra librería vista en modo 'Citation'. 

 

Ilustración 10: Acá estoy buscando la norma ISO que la U. de Chile recomienda usar en sus 

repositorios. 
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Ilustración 11: Nuestra librería, ahora citada según la norma ISO-690. 

 

Paso 4: Exportar archivo .bib 
 Las librerías de referencias creadas con Mendeley pueden ser exportadas como 

archivos de formato .bib. De esta forma las podemos enviar a colegas o a nosotros mismos. 

 Para exportar nuestra librería Tutorial, nos dirigimos a File → Export (Crtl+E) y elegimos 

el nombre y directorio del archivo para guardarlo.  

 Si tenemos muchas librerías o queremos tener el archivo .bib listo sin tener que 

exportarlo manualmente, nos dirigimos a Tools → Options → BibTeX y llenamos los campos 

de la ventana tal como aparece a continuación. 

 

Ilustración 12: Configuración para la creación automática de archivos BibTeX. 

 Elegimos el directorio de guardado (Path) para nuestras librerías. De esta forma se 

creará una carpeta con un archivo .bib por cada carpeta o grupo que hayamos creado 

en Mendeley Desktop. 
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Paso 5.1: Referenciar en Word 
 Dentro de Mendeley, vamos a Tools → Install MS Word Plugin. Al terminar el proceso, 

abrimos Word y nos dirigimos a “Referencias” en las pestañas superiores del documento. 

Nos aparecerá la sección “Mendeley Cite-O-Matic”. 

 

 

Ilustración 13: Herramientas para referencias en Word 2016. 

Para agregar una cita hacemos click en “Insert Citation” y seleccionamos la carpeta 

donde están guardados nuestros documentos. También podemos filtrar por autor y título 

para encontrarlos más rápido. 

 

Ilustración 14: Ventana emergente de Mendeley en Word 2016. 

Apenas encontremos la referencia que necesitamos, le damos a OK, así hasta 

terminar de escribir el texto. Luego, para crear un índice de referencias, hacemos click en 

“Insert Bibliography” y estarán todos los autores que hayamos citado. 

NOTA: Si un autor no está citado explícitamente en el texto, Mendeley no lo 

agregará a las referencias! Si quieren agregar o quitar autores a su texto después de insertar 

la bibliografía, sólo deben hacerle click a “Refresh” y esta se actualizará. 

Sobre estilos de citas: En “Style” pueden seleccionar el estilo que necesiten. 

Mendeley tiene una amplia gama de estilos para referenciar con Word. En este caso 

usamos el APA, pero también está el IEEE, Chicago, Nature, etc.  



9 

 

 

Ilustración 15: Nuestra creación, digna del Nobel de ciencias. 

 

Paso 5.2: Referenciar en Latex 
 Para esta sección, usaré la página Overleaf, un editor en línea gratuito para LateX; 

pero pueden usar su editor de LateX favorito. Dentro del programa he creado el preámbulo 

necesario para empezar el documento, al que llamé “test”.  Cargamos a Overleaf mi 

archivo de referencias obtenidos del Paso 4. 

Luego escribí mi gran investigación en el código, seguido por el comando 

\usepackage{apacite} (o también \usepackage{natbib}) y 

\bibliographystyle{apacite} (define el estilo usado para las citas y referencias, en este 

caso elegí que estuvieran en formato APA) y el comando \bibliography{nombre del 

archivo de referencias.bib}.  Luego, compilamos para que los Citation Keys sean 

reconocidos. 

Para agregar citas dentro del texto, ocupamos el comando \cite{} con el Citation 

Key dentro de los corchetes. Luego compilamos el texto, quedando de la siguiente forma: 
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Ilustración 16: Screenshot del código en Overleaf. 

 

Ilustración 17: Screenshot al PDF generado por el código. 

Para conocer más estilos de citas, pueden visitar el siguiente enlace: 

• https://www.overleaf.com/learn/latex/Natbib_bibliography_styles 

 

 

 

 

 

https://www.overleaf.com/learn/latex/Natbib_bibliography_styles
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Paso 5.3: Referenciar en Template Informes Latex de P. Pizarro (v7.0.0) 
 Accedemos a Overleaf (u otra página/programa con servicios similares) y cargamos 

el .zip de Template para Informes desarrollado por nuestro compañero Pablo Pizarro 

(https://latex.ppizarror.com/informe). Agregamos al proyecto el archivo de referencias 

“Tutorial.bib” obtenido del Paso 4; si lo abrimos vemos que este contiene toda la información 

de los tres documentos y sus Citation Keys correspondientes después de los ‘@’. 

  

 Recompilamos una vez el documento para que después reconozca las Citation 

Keys. Posteriormente, buscamos el archivo ‘template_config.tex’ dentro de la carpeta 

(como se muestra en la imagen). 

Usando Crtl+F buscamos la línea \def\stylecitereferences y la cambiamos a 

alguna de las siguientes opciones: 

• def\stylecitereferences {apacite}  

• def\stylecitereferences {natbib}  

Si usamos apacite, buscamos el comando \def\apacitestyle dentro del mismo 

documento y lo cambiamos a \def\apacitestyle{apacite} o 

\def\apacitestyle{apalike}. 

Si usamos natbib, buscamos el comando \def\natbibrefstyle, modificándola a 

\def\natbibrefstyle{ieeetr} o algún otro estilo de esta lista. 

Recompilamos una vez más. Ahora volveremos al main.tex y escribiremos nuestra 

gran investigación citando con el comando \cite{}, colocando dentro de los {} nuestros 

Citation Keys. Terminamos nuestro documento agregando el comando \bibliography{ 

NOMBRE DEL ARCHIBO .BIB}; recompilamos y obtenemos lo siguiente: 

https://latex.ppizarror.com/informe
https://www.overleaf.com/learn/latex/Natbib_bibliography_styles#Natbib_styles
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Ilustración 18: Screenshot al código de LateX. 

 

Ilustración 19: Screenshot al texto compilado en el visor de PDFs. 

 

¿Cómo sacarle más provecho a las citas en LaTex? 
 

Existen numerosos comandos que podemos utilizar en LaTex para referenciar 

mientras escribimos. A continuación, les dejo algunos cuantos bien útiles: 

\cite{CitationKey}  
   
 
 
\cite{CitationKey1, CitationKey2}
   
 
 
 
 
\shortcite{CitationKey}   
 
 
 
 

La más básica. Muestra la cita con un 

formato de (Autor(es), Año).  

 

Permite referenciar a dos o más 

documentos al mismo tiempo. Muestra la 

cita con formato de (Autores 1, Año 1; 

Autores, Año 2).  

 

Útil si la referencia tiene muchos autores y 

no queremos que el documento los liste a 

todos en el texto. Muestra la cita en 

formato (Autor et al., Año). 
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\citeauthor{CitationKey} 
  
 
 
\shortciteauthor{CitationKey} 
 
  
 
\citeyear{CitationKey}   
 
 
\nocite{CitationKey}  

 

 
\citeNP{CitationKey} 
 
 
\citeA{CitationKey} 

Nombra a los autores sin uso de paréntesis. 

No muestra el año. 

¿El comando anterior cita a muchos 

autores? Este entrega una cita en formato 

"Autor et. al" 

 

Entrega sólo el año de publicación del 

documento, sin paréntesis. 

 

Sirve para agregar el documento a la lista 

de referencias sin citarlo dentro del texto. 

 

Crea una cita simple Autor, Año sin 

paréntesis. 

 

Crea una cita del tipo Autor (Año). 

 

 En el caso de que se trabaje en Overleaf (u otro editor online que interactúe con 

Mendeley) es posible sincronizar la librería del programa Mendeley. Esto es increíblemente 

útil para documentos en los que aún no hemos finalizado nuestra investigación y seguimos 

agregando nuevos archivos, ¡pero también para proyectos en conjunto! 

 Nos dirigimos al menú para agregar archivos de Overleaf, y seleccionamos “From 

Mendeley”.  

 

Seleccionamos el nombre del grupo de trabajo donde se encuentran nuestros 

archivos (sí, solo funciona para grupos, no para librerías personales     ) y escribimos el 

nombre con el cual se importará el archivo .bib a Overleaf. 

 

Ilustración 20: Esa flechita significa que está siendo exportado directamente desde Mendeley. 
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 ¿Agregaste un nuevo archivo a Tutorial.bib y quieres referenciarlo? Hacemos click 

en el archivo importado ‘references.bib’ y apretamos ‘Refresh’. La fecha de importación 

debería cambiar cuando se complete el proceso, tal como muestra la ilustración inferior. 

 

NOTA: Uno de los problemas que me he encontrado importando directamente el archivo 

.bib en trabajos grupales es que no todos pueden apretar ‘Refresh’. La hipótesis a la que 

hemos llegado es que sólo quien importa el archivo puede actualizarlo posteriormente, 

pero pueden haber otros motivos. Si tienen soluciones a esto por favor envíenme un correo 

para agregarlo       

 


